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Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our web site
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page number. The numbering convention for the DS number is
“DSXXXXXA", where “XXXXX” is the document number and “A” is the revision level of the
document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help.
Select the Help menu, and then Topics to open a list of available online help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
RTD Reference Design. Items discussed in this chapter include:

¢ Document Layout

» Conventions Used in this Guide

« Recommended Reading

* The Microchip Web Site

¢ Customer Support

* Document Revision History

DOCUMENT LAYOUT

This document describes how to use the RTD Reference Design as a development tool
to emulate and debug firmware on a target board. The manual layout is as follows:

e Chapter 1. “Product Overview” — Important information about the RTD
Reference Design.

» Chapter 2. “Installation and Operation” — This chapter includes a detailed
description of each function of the demo board and instructions for how to begin
using the board.

* Appendix A. “Schematic and Layouts” — Shows the schematic and layout
diagrams for the RTD Reference Design.

« Appendix B. “Bill of Materials” — Lists the parts used to build the RTD
Reference Design.

© 2010 Microchip Technology Inc. DS51891A-page 5
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description

Represents

Examples

Arial font:

Italic characters

Referenced books

MPLAB® IDE User'’s Guide

Emphasized text

...Is the only compiler...

dialog

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer
Quotes A field name in a window or | “Save project before build”

Underlined, italic text with A menu path File>Save
right angle bracket
Bold characters A dialog button Click OK

Atab

Click the Power tab

N‘Rnnnn

A number in verilog format,
where N is the total number of
digits, Ris the radix and nis a
digit.

40010, 2'hF1

Text in angle brackets < >

A key on the keyboard

Press <Enter>, <F1>

Courier New font:

Plain Courier New

Sample source code

#defi ne START

Filenames aut oexec. bat

File paths c:\nccl8\h

Keywords _asm _endasm static
Command-line options - Qpa+, -Opa-

Bit values 0, 1

Constants OxFF, ‘A

Italic Courier New

A variable argument

file.o,wherefilecanbe
any valid filename

Square brackets [ ]

Optional arguments

nccl8 [options] file
[opti ons]

Curly brackets and pipe
character: { |}

Choice of mutually exclusive
arguments; an OR selection

errorlevel {0]1}

Ellipses...

Replaces repeated text

var _name [,
var _nane. . .|

Represents code supplied by
user

void main (void)
{
}

DS51891A-page 6
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RECOMMENDED READING

This user's guide describes how to use the RTD Reference Design. Other useful
documents are listed below. The following Microchip documents are available and
recommended as supplemental reference resources.

MCP3551 Data Sheet, “Low-Power, Single-Channel 22-Bit Delta-Sigma ADCs”
(DS21950)

This data sheet provides detailed information regarding the MCP3551 device.
AN1154 — “Precision RTD Instrumentation for Temperature Sensing” (DS01154)

This application note provides information on the RTD Instrumentation technique for
high performance thermal management applications.

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web
site is used as a means to make files and information easily available to customers.
Accessible by using your favorite Internet browser, the web site contains the following
information:

* Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents,
latest software releases and archived software

« General Technical Support — Frequently Asked Questions (FAQs), technical
support requests, online discussion groups, Microchip consultant program
member listing

* Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events, listings of Microchip sales offices,
distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

« Distributor or Representative
 Local Sales Office

« Field Application Engineer (FAE)
« Technical Support

Customers should contact their distributor, representative or field application engineer
(FAE) for support. Local sales offices are also available to help customers. A listing of
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com

DOCUMENT REVISION HISTORY
Revision A (September 2010)

« |nitial Release of this Document.

© 2010 Microchip Technology Inc. DS51891A-page 7
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Chapter 1. Product Overview

INTRODUCTION

The following name and assembly number are found on the RTD Reference Design’s
Printed Circuit Board (PCB):

» 102-00115

WHAT IS THE RTD REFERENCE DESIGN?

The RTD Reference Design demonstrates how to implement a Resistive Temperature
Detector (RTD) and accurately measure temperature. This solution uses the MCP3551
22-Bit Analog-to-Digital Converter (ADC) to measure voltage across the RTD. The
ADC and the RTD are referenced using an on-board reference voltage, and the ADC
inputs are directly connected to the RTD terminals. This provides a ratio metric temper-
ature measurement. The solution uses a current limiting resistor to bias the RTD. It pro-
vides a reliable and accurate RTD instrumentation without the need for extensive circuit
compensation and calibration routines.

In addition, this reference design includes a silicon temperature sensor, MCP9804.
This sensor is used for comparison only, it is not needed for the RTD instrumentation
circuit. The MCP3551 and MCP9804 outputs are read using a USB PIC® MCU. This
controller is also connected to a PC using USB interface. The Thermal Management
software is used to plot the RTD temperature data in strip chart format.

WHAT THE RTD REFERENCE DESIGN KIT INCLUDES

This RTD Reference Design Kit includes:

* RTD Reference Design, 102-00115
* USB cable
* Important Information Sheet

© 2010 Microchip Technology Inc. DS51891A-page 9
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Chapter 2. Installation and Operation

2.1 INTRODUCTION

The RTD Reference Design demonstrates Microchip’s solution to accurately measure
temperature using a 22-bit ADC, MCP3551. This solution eliminates the need for the
traditional analog instrumentation system calibration or gain and offset trimming
techniques. In addition, the effect of self-heat can be minimized by limiting the RTD
biasing current using a single resistor.

This reference design uses the technique described in Application Note AN1154 —
“Precision RTD Instrumentation for Temperature Sensing” (DS01154). The RTD
Reference Design allows the user to evaluate Microchip’s solution to accurately
measure temperature using an RTD. RTD resistance availability typically ranges from
10002 to 5000Q. When biasing an RTD to measure temperature, self-heat due to power
dissipation has to be considered. In order to output measurable voltage across the RTD
for wide temperature range, the biasing current has to be relatively high. This causes
higher power dissipation through heat and skews the temperature reading. This
solution uses a ratiometric technique between the RTD resistance and the ADC
resolution to achieve high accuracy throughout the entire sensor range.

This solution uses an on-board (local) surface mount RTD and an external RTD. The
local and external RTDs are selected using JP2. The MCP9804 temperature sensor is
also used to measure local temperature.

The MCP3551 and the MCP9804 serial output lines are connected to a PIC MCU. RTD
linearization is computed with the microcontroller. This controller communicates with a
PC via the USB interface. The temperature data is then displayed on the PC using the
Thermal Management software in strip chart format.

2.2 FEATURES

The RTD Reference Design has the following features:

e Surface mount PT100 RTD

« External RTD connector (not included)

e Thermal Management GUI

e 22-Bit ADC MCP3551

e 1£1°C Maximum accuracy temperature sensor MCP9804
* PIC18F2550 microcontroller

« USB interface to PC

© 2010 Microchip Technology Inc. DS51891A-page 11
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2.3 GETTING

STARTED

This section describes how to quickly configure the RTD Reference Design. A
simplified block diagram of the configuration is provided in Figure 2-1.

Vbb Vv
T LDO i LDO
1
£ = T° Re 5%
= = VREerF
1
! “fg RA 1%
Voo VREF N .
RTD
o] 3 MCP3551
MCU 7 sp
- L
FIGURE 2-1: RTD Reference Design Simplified Block Diagram.

2.3.1 Hardware Setup

1. Connect the USB cable to PC
2. Select JP2 for Local/External RTD
3. Start the Thermal Management software

2.3.2 Software Setup

Once the USB interface is secured, start the Thermal Management Software. When the
software starts, if the hardware is successfully detected, the GUI will be displayed
(Figure 2-2).

- 1=K N2 im|
RTD Setup | MCP9804 Setup | o
RTD Corfiguration Data Acquisition
L]
RTD IC Sensor
= < Measurement Units
Resistance | 100 Ohm | 12 2
e (® Ceksius (T}
RTD Temperature D-C © Fahrenhet (F) 100 100
Siam G 80 80
. =
S 60 Loo O
= @
g =
RTD Calibration 2 4 40 3
- — E s
Calibration | Set Bias Hesistor a 20 20 é
2
Calibration Temperature (C) l ] (14 ] 0
RTD Calibration Offsst (C) | ] 20 —-20
40, L . 40
0 45 90 135 180 225 270 315 360 405 450 495
See application note AN1154 at www microchip.com Data Buffer
RTD linearization Equation Provided by ASTM (Spec. # E 1137)
Leam more about RTD at www temperatures.com Sampling Interval fms):
< 3([500_|
FIGURE 2-2: RTD Reference Design GUI.
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Installation and Operation

This Configuration window allows the user to set some parameters, such as
measurement unit and calibration temperature.

The Play, Stop, and Reset icons (Figure 2-3) can be used to perform a continuous

data-log. The Record icon enables the user to data-log to an external file. The logging
interval can be adjusted using the Interval Scroll bar from 100 ms to 30s.

Stop Recording Real-Time acquisition
Start/Record Real-Time acquisition
Reset Real-Time acquisition

Stop Real-Time acquisition

Start Real-Time acquisition

A Me 098142 Ival eatio

DM@

FIGURE 2-3: Real-Time Acquisition.

The RTD temperature is linearized using ASTM specification #E 1137. The
linearization is implemented in the PIC MCU.

The Data Acquisition charting tool can be customized by double-clicking the chart, as
shown in Figure 2-4. Additional options are available by right-clicking the chart. The
user can also zoom into a specific plot range by clicking and dragging the section. The
data in the chart can also be exported using the Export button.

data aquisition Customization...

General | Plat | Subsets Fuaintz | Bz | Font | Color Style
Mair Title: data aquisition
Sub Title:
Border Shyle Mumenic Precizion
() Mo Border ) Line o @1 Oz O3
(%) Shadow (130 Inzet
Yiewing Style Grid Lines
() Calar (#) Both Oy Ox O Mone
() Monochrome Grid in frant of data
(O Monochiome + Syrmbols Display
Faort Size (%) Graph () Table () Both
(%) Large () Medium ) Small
Ok l ’ Cancel Export. . b aximize. .

Export Data

FIGURE 2-4: Chart Setup Options.
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2.3.3 Sensor Calibration

2.3.3.1 RTD SETUP

The RTD sensor can be calibrated using the GUI. Once the RTD is exposed to the dies
calibration temperature, simply type in the temperature in the Calibration Temperature
field and click the Calibrate button. When the temperature is calibrated and the
calibration offset is stored in the PIC MCU EEPROM, the calibration offset is displayed
in the RTD Calibration Offset text box. The Reset button resets the calibration offset to
“0".

RTD Calibration

Calibration | Set Bias Fesistor

Calibration Temperature {°C)
RTD Calibration Offset ('C)

FIGURE 2-5: Sensor Calibration.

The GUI also enables users to set the RTD biasing resistor value, Rg. If a resistor other
than a 100Q2 RTD resistor is connected, then replace Rq (for operation and details refer
to AN1154). The Reset button sets Rq to the default value of 6800Q.

RTD Calibration

Calibration | Set Bias Resistor

Set Fa Value fohm)

[ sett | [ Reset |

Mate: The default Value is 6800 Ohm (RS on PCE)

FIGURE 2-6: Setting RTD Biasing Resistor.
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2.3.3.2 MCP9804 SETUP

The MCP9804 is a silicon temperature sensor which measures temperature with
+0.25°C nominal and +1°C maximum accuracy from -40°C to +125°C. This sensor has
multiple user programmable features such as Alert Output limits, output hysteresis and
mode (see Figure 2-7). The output mode can be set up as either comparator or
interrupt output with active-high or active-low levels. The temperature measurement
resolution can also be set up.

RTD Setup | MCP3804 Setup

MCP5804 Configuration

Hysteresis

® 0C O 15T
O ac O BC
Resolution

® 05C O 025

QO 0.125C O 0.06257C

Conversion
(® Continuous () Shutdown

Alert Output Cortrol
[] Enable Alert Fin

Comparator Active High
Intemupt Active Low
Alert output

Int. Clear fﬁ:ﬂi"gﬁ?l

Tertical Lock Twindow Lock

Enable Sensor

Registers
Capability

Resolution

Tlower
Teritical
Manu 1D

DevID/Rev

0
0
0C

FIGURE 2-7:

MCP9804 Setup.
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DS51891A-page 15



RTD Reference Design

NOTES:

DS51891A-page 16 © 2010 Microchip Technology Inc.



MICROCHIP RTD REFERENCE DESIGN

Appendix A. Schematic and L ayouts

A.1 INTRODUCTION
This appendix contains the following schematics and layouts for the RTD Reference
Design:
* Board — Schematic
« Board — Top Silk and Pads
« Board — Top Layer
» Board — Bottom Silk and Pads
» Board — Bottom Layer

© 2010 Microchip Technology Inc. DS51891A-page 17
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BOARD — SCHEMATIC
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Schematic and Layouts

A.3 BOARD - TOP SILK AND PADS

‘ o0eRE vooli Bonol
ScK/SoL MCP9804
Sensor R10
ALERT
- JP1 O
RTD Reference - - O
Design o
° crlm ll L R9 RTD .
RCO C17 J1
® c7 = External Local
L] 00| 2
SDA/SDO 192—-00115 R12

A.4 BOARD -TOP LAYER

ooo *= vooff Bono

MCP9804
SCK/SCL Sensor 1o
: T
=G =

o
SDA/SDO 192—-00115 R1
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A5 BOARD -BOTTOM SILK AND PADS
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RTD REFERENCE DESIGN

Appendix B. Bill of Materials

TABLE B-1: BILL OF MATERIALS
Qty Refeerenc Description Manufacturer Part Number
4 |C1,C6, |CAP .1UF 25V CERAMIC X7R 0805 Panasonic® — ECG ECJ-2VB1E104K
C11, C17
2 |c2,C7 CAP 1.0UF 16V CERAMIC X7R 0805 Kemet® Electronics C0805C105K4RACTU
2 |C3,C4 CAP 10UF 10V CERAMIC F 0805 Panasonic — ECG ECJ-2FF1A106Z
1 |[C10 CAP .47UF 16V CERAMIC X7R 0805 Panasonic — ECG ECJ-2YB1C474K
2 |C13,C14 |CAP 22PF 50V CERM CHIP 0805 SMD Panasonic — ECG ECJ-2VC1H220J
1 |J2 CONN TERM BLOCK 2.54MM 4POS Phoenix Contact 1725672
1 |33 CONN MINI USB RCPT RA TYPE B SMD | Tyco Electronics 1734035-2
1 |J5 DO NOT POPULATE — —
HEADER 1X6
1 |JP1 DO NOT POPULATE Tyco® Electronics/Amp 2-382811-1
SHUNT ECONOMY 2POS .100 TIN
1 JP1 DO NOT POPULATE Tyco Electronics/Amp 3-644695-2
CONN HEADER VERT 2POS .100 TIN
1 |JP2 CONN HEADER VERT 2POS .100 TIN Tyco Electronics/Amp 3-644695-2
1/16 2 | JP2 3 POS Jumper Switch ITW® Pancon JSC416G0
1 (L1 INDUCTOR 10UH 100MA 0805 Murata Electronics® LQM21FN100M70L
1 PCB RoHS Compliant Bare PCB, Microchip Technology Inc. | 104-000115
RTD Reference Board
3 |R1,R2, |RES 10.0K OHM 1/8W 1% 0805 SMD Panasonic — ECG ERJ-6ENF1002V
R6
1 |R4 RES 1.0 OHM 1/8W 1% 0805 SMD Panasonic — ECG ERJ-6RQF1R0OV
2 |R9,R12 |RES 6.8K OHM 1/10W .1% 0805 SMD Panasonic — ECG ERA-6YEB682V
1 |R10 RES 0.0 OHM 1/8W 5% 0805 SMD Panasonic — ECG ERJ-6GEYOROOV
1 |R11 PLATINUM RTD CHIP TEMPERATURE |ENERCORP Instruments PCS 1.1503.1
SENSOR SMD (RTD) Ltd.
TP1-TP8 | TEST POINT PC COMPACT SMT Keystone Electronics® 5016
1 Ul 28/40/44-Pin, High-Performance, Microchip Technology Inc. | PIC18F2550-1/SO
Enhanced Flash, USB Microcontrollers
with nanoWatt Technology
U2 IC ADC 22BIT 2.7V 1CH SPI 8SOIC Microchip Technology Inc. | MCP3551-E/SN
1 u3 Low Dropout Positive Voltage Regulator Microchip Technology Inc. | MCP1701T-50021/CB
u4 2-Wire High-Accuracy Temperature Microchip Technology Inc. | MCP9804T-E/MC
Sensor
1 |vY1 CRYSTAL 20.0000 MHZ SERIES SMT CTS® Electronic ATS200SM
Components
Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM

used in manufacturing uses all RoHS-compliant components.
2:  Jumper switch comes in strips of 16 switches. Cut individual jumper switch as needed.

© 2010 Microchip Technology Inc.
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Fax: 86-29-8833-7256

China - Xiamen
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Fax: 81-45-471-6122

Korea - Daegu
Tel: 82-53-744-4301
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Tel: 66-2-694-1351
Fax: 66-2-694-1350

EUROPE

Austria - Wels

Tel: 43-7242-2244-39
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KomnaHus ((3J'IeKTpO|_|J'|aCT» npeanaraeT 3akKn4vyeHmne onrocpoYHbIX OTHOLLIEHUN npu
NOoCTaBKaxX MMMNOPTHbIX 3NTEKTPOHHbIX KOMMOHEHTOB Ha B3aMMOBbLIFO4HbIX yCJ'IOBI/lFlX!

Hawwn npeumyuiectsa:

e OnepaTuBHbIE NOCTABKM LUMPOKOrO CMeKTpa 3NeKTPOHHbIX KOMMNOHEHTOB OTEYECTBEHHOIO U
MMMOPTHOrO NPON3BOACTBA HANPAMYO OT MPOM3BOAMTENEN U C KPYNMHENLLNX MUPOBbLIX
CKNaaos.;

MocTaBka 6onee 17-TM MUNIIMOHOB HAMMEHOBAHWUIN 3NEKTPOHHbLIX KOMMNOHEHTOB;

MocTaBka CNoXHbIX, AeULNTHBIX, MMOO CHATLIX C MPOM3BOACTBA NO3ULIUIA;

OnepaTtunBHbIE CPOKM NOCTABKM Nof 3aka3 (0T 5 pabounx gHewn);

OKcnpecc goctaska B Nnobyto Touky Poccuu;

TexHnyeckas nogaepkka npoekTa, NomMoLLlb B nogdope aHanoros, NocTaBka NPOTOTUMOB;

Cuctema MeHeXMeHTa KavyecTBa cepTuduumnposaHa no MexayHapogHomy ctaHgapTty 1ISO

9001;

o JlnueHausa ®CH Ha ocyulecTBneHne paboT ¢ NCNONb30BaHWEM CBEOEHUIN, COCTABAOLLINX
rocygapCTBEHHYIO TalHy;

o [locTaBka cneumnanmampoBaHHbIX KOMNoHeHToB (Xilinx, Altera, Analog Devices, Intersil,
Interpoint, Microsemi, Aeroflex, Peregrine, Syfer, Eurofarad, Texas Instrument, Miteq,
Cobham, E2V, MA-COM, Hittite, Mini-Circuits,General Dynamics v gp.);

MoMMMO 3TOro, O4HMM M3 HanpaBnNeHU koMnaHum «AnekTpollnacT» ABNseTca HanpaBneHne

«UcTouHmkn nutaHua». Mel npeanaraem Bam nomoub KoHCTpyKTOpCKOro otaena:

e [logGop onTuManeHOro peleHus, TexHn4eckoe 060CHOBaHME Npu BbIOOpPE KOMMOHEHTA;
Monbop aHanoros.;
KoHcynbTaumm no NpUMEHEHMIO KOMMOHEHTA;
MocTaBka 06pa3yoB M NPOTOTUMNOB;
TexHn4veckasn noaaepka npoekTa;
3awmTa OT CHATMSA KOMMOHEHTA C NPON3BOACTBA.

Kak c Hamu cBfizaTbCcA

TenedoH: 8 (812) 309 58 32 (MHOrokaHanbHbIN)
Pakc: 8 (812) 320-02-42

OnekTpoHHas nouTta: org@eplastl.ru

Aapec: 198099, r. Cankt-INeTepbypr, yn. KannHuHa,
Oom 2, kopnyc 4, nutepa A.
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